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CAUTION
Indicates that incorrect operation presents possibility of injury to
the user or damage to the equipment.

NOTE Denotes items of advice related to performance of the
equipment or to its correct operation.

Introduction

Notes on Use

Thank you for purchasing this HIOKI "9333 LAN COMMUNICATOR."
To get the maximum performance from the unit, please read this manual
first, and keep this at hand.

Trademarks
Pentium is a registered trademark of Intel Corporation.
Windows is a registered trademark of Microsoft Corporation.

In order to ensure safe operation and to obtain maximum performance from
the unit, observe the cautions listed below.

Always hold the disc by the edges, so as not to make fingerprints on the
label side or scratch the printing.
Never touch the recorded side of the disc. Do not place the disc directly
on anything hard.
Do not wet the disc with volatile alcohol or water, as there is a possibility
of the label printing disappearing.
To write on the disc label surface, use a spirit-based felt pen. Do not use a
ball-point pen or hard-tipped pen, because there is a danger of scratching
the surface and corrupting the data. Do not use adhesive labels.
Do not expose the disc directly to the sun's rays, or keep it in conditions
of high temperature or humidity, as there is a danger of warping, with
consequent loss of data.
To remove dirt, dust, or fingerprints from the disc, wipe with a dry cloth,
or use a CD cleaner. Always wipe radially from the inside to the outside,
and do no wipe with circular movements. Never use abrasives or solvent
cleaners.
In the interests of ongoing product developments, there may be minor
discrepancies between screen displays and the operating instructions, and
in the data conversion process.
HIOKI cannot accept any responsibility for the results of using this
product.

The following symbols are used in this Instruction Manual to indicate the
relative importance of cautions and warnings.
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1.1 Product Overview
______________________________________________________________________________________________

NOTE
･ When not using a LAN (when no LAN card is installed), and the memory

recorder function time axis setting is 10 ms/division or above, the waveform is
displayed sequentially. However, when a LAN is used, the waveform is only
displayed sequentially if the setting is 100 ms/division or above.*

Similarly, in roll mode the minimum setting is 100 ms/division.
･ It can not be monitored by Remote control application while it is measured with

X-Y CONT recorder.
･ When the Recorder function time axis setting is 20 ms/DIV, it can not be

monitored by 8826 with the Remote control application during the measurement.

Chapter 1
Overview

1.1 Product Overview

The 9333 LAN COMMUNICATOR comprises the following three software
applications.

1. Remote control (RmtCtrl)
This application provides remote control of the Memory HiCorder from a
computer, through a LAN. This allows you to make settings on the
Memory HiCorder and carry out simple monitoring.
You can transfer waveform data from the Memory HiCorder to the
computer, and print reports on the computer.

2. Data collection (Accumulator)
This software provides Memory HiCorder auto save and auto print
functions on the computer.
A single computer can collect data from multiple Memory HiCorders, for
centralized handling of Memory HiCorder measurement data on the
computer, or printing of waveform data using the computer's printer.

3. Waveform viewer (Wv)
This provides a simple viewing facility for waveform files transferred
from the Memory HiCorder being used for remote control and data
collection.
You can convert binary data to CSV format: CSV files are convenient
because they can be read into spreadsheets and other software.

*: except MR8827, MR8847A, MR8847, 8847, MR8740, MR8741 (These models follow
the "roll mode" settings)



2
_____________________________________________________________________________________________

1.2 Specifications
______________________________________________________________________________________________

Supplied medium One CD-R

Supported recorders HIOKI MR8827, MR8847A, MR8847, 8847,
MR8740, MR8741, 8730, 8731, 8826, 8835-01,
8841, 8842, 8855, 8720

Operating environment Windows 10/ 8/ 7/ Vista/ XP
(with LAN installed and TCP/ IP available)

Communications Ethernet, TCP/ IP

1.2 Specifications

General specification

Functional specifications
(1) Remote control application (RmtCtrl)
･ Memory HiCorder remote control function

Control carried out by sending key codes and receiving screen image
･ Report printing
･ Screen shot printing
･ Receiving waveform data files

Same format as the Memory HiCorder waveform save function, but
binary only, and if the cursors are shown, only the interval between the
cursors.

(2) Data collection application (Accumulator)
･ Receiving Memory HiCorder auto save files

Same format as the Memory HiCorder auto save function, but
waveform data is binary only (text format can be selected in
MR8827, MR8847A, MR8847, 8847, MR8740, MR8741, 8730, 8731,
8855), and if the cursors are shown, only the interval between the
cursors. (MR8827, MR8847A, MR8847, 8847, MR8740, MR8741,
8855 are depending on the format that you set in the Memory
HiCorder)
･ Memory HiCorder auto print function, printing on the computer
･ Memory HiCorder screen hard copy function, printing on the computer

(MR8827, MR8847A, MR8847, 8847, MR8740, MR8741, 8855 are
not supported)
･ Memory HiCorder PRINT key, printing on the computer

(3) Waveform viewer (Wv)
･ Waveform file display (support for binary files in MEM, REC, RMS,

and POW format)
･ Conversion to CSV format (can thin, or specify section)
･ Display format settings (scroll function, zoom display, display channel

setting)
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2.1 System Configuration Required
______________________________________________________________________________________________

NOTE
Note that in data collection, when transferring large quantities of waveform data
from the Memory HiCorder, a corresponding amount of hard disk space is required.
The hard disk capacity provided should be in line with expected volumes of data.

Chapter 2
Setup

2.1 System Configuration Required

Using the 9333 requires the following hardware and software.

Computer
･ Free hard disk capacity: 5 MB

Operating system
Microsoft Windows 10, Windows 8, Windows 7, Windows Vista, or
Windows XP

LAN
Hardware for network connection installed
TCP/IP available on the network

CD-ROM drive
Used for installation.

Printer
Required for printing Memory HiCorder data on the computer.
Either a color or monochrome printer can be used, but as far as possible a
high-speed printer is recommended.



4
_____________________________________________________________________________________________

2.2 Installing and Uninstalling the Software
______________________________________________________________________________________________

NOTE
･ When installing, if other application are running it may not be possible to

complete the installation. As far as possible, close all other applications before
beginning the installation. In particular, if any anti-virus software is running, it
may prevent the installation, even though it is not a virus. In this case, make the
appropriate settings in the anti-virus software to allow the installation to proceed.
･ When upgrading versions, uninstall the old version of 9333 before installing the

new version of 9333. After installation, confirm the version information on the
"Help" menu.

2.2 Installing and Uninstalling the Software

Installation
Use the following procedure to install the software.
1. Shut down all currently running applications.
2. Insert the supplied CD-R disc into the CD-ROM drive.
3. Execute the setup file on the CD-R.

Supposing the drive letter for the CD-ROM drive is R (if another letter,
substitute before the colon) then in the Windows Start menu, select Run,
and enter R:\english\setup.exe, then click OK.

4. The 9333 installer start: follow the directions on the screen to complete
the installation.

Uninstallation
Use the following procedure to uninstall the software.
1. Shut down all currently running applications.
2. Insert the supplied CD-R disc into the CD-ROM drive.
3. Execute the setup file on the CD-R.

Supposing the drive letter for the CD-ROM drive is R (if another letter,
substitute before the colon) then in the Windows Start menu, select Run,
and enter R:\english\setup.exe, then click OK.

4. The 9333 uninstaller start: follow the directions on the screen to complete
the uninstallation.

All transferred data files remain, but can be removed manually when no
longer required.
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2.3 Checking the Memory HiCorder Version
______________________________________________________________________________________________

NOTE
Depending on the version of your Memory HiCorder, the software may be an
enhanced version in place of the normal version. The CD-R includes only normal
versions, so in this case a separate upgrade is required. Consult your HIOKI service
representative.

2.3 Checking the Memory HiCorder Version

To use the 9333 LAN Communicator, the software in the Memory HiCorder
must have 9333 support. First check the Memory HiCorder version number:
you can find this on the System screen of the Memory HiCorder.
For more details, refer to the Instruction Manuals for the Memory HiCorder.
Versions compatible to 9333 are ver 2.30 or later for 8826, 8841, 8842, ver
1.10 or later for 8835-01, ver 5.10 or later for 8835-01 High performance
model (9540-01), ver 2.00 or later for 8720, ver 1.00 or later for 8855, ver
1.10 or later for 8730, 8731, and ver 3.07 or later for MR8847, 8847, and ver
3.12 or later for MR8740, and ver 2.12 or later for MR8741.
When Memory HiCorder is not compatible with 9333, upgrade the unit
application software. According to the version-up instructions for each model
contained in the CD-R, please been upgraded.
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2.4 LAN Settings
______________________________________________________________________________________________

CAUTION Before connecting to the LAN for the first time, it is important to complete the
Interface settings. If the unit is connected to the LAN without making these
settings, there may be IP address conflicts with other devices on the network
or other problems.

Host Name (up to 12 characters)  : __________________

IP Address           : ____.____.____.____

Subnet Mask          : ____.____.____.____

Default Gateway (present or not present, when present)
               : ____.____.____.____
TCP/IP Port Number       : ____X
You can set the upper three decimal digits of the port address
(the rightmost digit is set internally by this device).

2.4 LAN Settings

Preparations for the settings

First, when connecting to an existing network, it is necessary to obtain the
settings from the network system administrator. You will need to obtain the
following from your network administrator.
･ Host name

This is the name of the Memory HiCorder in the network. It must be
distinct from the host names of all other devices in the network.
･ IP address

This is the identifying address for the Memory HiCorder. It must be
distinct from the addresses of all other devices in the network.
･ Subnet mask

This specifies the class (size) of the network.
･ Default gateway

Specify a gateway if communications from the Memory HiCorder to the
computer pass through one.
･ TCP/IP port number

This is the port used for TCP/IP communications between the Memory
HiCorder and the computer. Normally the default 880x ports can be used,
but if these ports are already used by a different program on the computer,
specify different ports.

When the port number is specified as "880x" the ports used are as follows:
･ Port 8800: for remote control application
･ Port 8801: for data collection application
･ Port 8802: for control by GP-IB commands
･ Ports 8803 to 8809: reserved
Use ports on the computer running the 9333 software that are unused.
Note that the ports are mapped to IP addresses, and do not have any relation
to the ports used by other devices in the LAN.
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2.4 LAN Settings
______________________________________________________________________________________________

Of course, if assembling a stand-alone network with no connection to an
existing network, you can still obtain the address information from the
administrator, or if there is no administrator, you can assign the setup values
yourself.
An IP address within the following range is recommended when setting up
such a stand-alone network: 192.168.0.0 to 192.168.255.255.
However, the rightmost number may not be 0 or 255, so we recommend
setting the controller device (PC, etc.) to 192.168.0.1, and setting this unit to
192.168.0.2. If several Memory HiCORDERs are to be connected, the last
number should be incremented by one for each unit (e.g., the next unit
would be 192.168.0.3).
The Host Name should be carefully selected to be unique among the Host
Names assigned to all other devices.
Otherwise, the following settings should be satisfactory:
Subnet Mask : 255.255.255.0
Default Gateway : OFF
Port Number : 880X
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2.4 LAN Settings
______________________________________________________________________________________________

This is required for the data collection function.
For details see Section 4.3.5.

Example: 8841/42

NOTE ･ Using the 8841, 8842, 8826, 8835-01 and 8720
If no LAN card is inserted, the Settings screen does not appear, so be sure to
insert the LAN card before making the settings.
For details of the settings, refer to the Instruction Manuals supplied with the 9578
10 BASE-T LAN CARD.
･ Using the MR8827, MR8847A, MR8847, 8847, MR8740, MR8741, 8730, 8731, 8855

For details of the settings, refer to the Instruction Manuals supplied.

Settings on the Memory HiCorder
Carry out the Memory HiCorder settings in the System screen.
Do not change the settings during a communications session.
The settings take effect when you press the Confirm function key. In other
words, do not press Confirm for each individual setting, but only after
completing all the settings.

･ The delimiter and header settings are used for control by GP-IB
commands.

Settings on the computer
Using this software requires the computer to have a LAN connection
installed. For details of the LAN settings, consult the Windows "Help" files,
or the documentation supplied with the computer's LAN card. The TCP/IP
protocol must be available for use.
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3.1 Starting the Remote Control Application
______________________________________________________________________________________________

Chapter 3
Remote Control (RmtCtrl)

3.1 Starting the Remote Control Application

In the Windows Start menu, select Programs, HIOKI 9333 LAN
Communicator, and Remote Control. This starts the remote control
application.
To close the remote control application, in the Connection menu select Exit.
You can also click the Close button at the top right corner of the window.

Toolbar
Click the icons in the toolbar for the respective functions.
From the left, these are: Connect, Disconnect, Save Screen, Print Screen,
Toggle Key Dialog Bar, Get/Save Waveform Data, Get/Print Report Image,
and Get/Send Comments.
For details of these operations, see the descriptions of the corresponding
menu items.

Status bar
The status bar shows, from the right, the model name and its operating
status.
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3.2 Remote Control Menus
______________________________________________________________________________________________

[ Connection ]

[ View ]

[ Data Transfer ]

[ Help ]

[ Timeout Setting... ] Refer to 3.7.1

[ Screen Interval Transfer Settings... ] Refer to 3.7.2

[ Key Repeat Settings... ] Refer to 3.7.3

[ Save Screen... ] Refer to 3.7.4

[ Print Screen... ] Refer to 3.7.5

[ Print Preview... ] Refer to 3.7.5

[ Disconnect ] Refer to 3.4

[ Connect ] Refer to 3.3

[ Page Settings... ] Refer to 3.7.6

[ Exit ] Refer to 3.1

[ Key Dialog Bar ] Refer to 3.4

[ Get/Send Comments ] Refer to 3.7.7

[ Fix Display Size ] Refer to 3.4

[ Adjust Display Size ] Refer to 3.4

[ Toolbar ] Refer to 3.4

[ Status Bar ] Refer to 3.4

[ Orientation ] Refer to 3.4

[ Enable Screen Keys ] Refer to 3.4

[ Get/Save Waveform Data... ] Refer to 3.5

[ Get/Print Report Image... ] Refer to 3.6

[ About RmtCtrl... ] Refer to 3.7.10

[ Escape from Key Check Screen ] Refer to 3.7.8

[ Send Print Key ] Refer to 3.7.9

[ About the MEMORY HiCORDER ] Refer to 3.7.10

3.2 Remote Control Menus

The following is the complete menu tree of the remote control application.
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3.3 Connecting to the Memory HiCorder
______________________________________________________________________________________________

3.3 Connecting to the Memory HiCorder

In the remote control application Connection menu, select Connect. This
displays the following Connection dialog box: enter the recorder's IP address
and port number.
The IP address is the IP address set on the Memory HiCorder System screen.
The port number is also set on the System screen, and in the example show,
when "880x" was set, enter "8800" here.

Next click the Connect button to connect to the Memory HiCorder.
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3.4 Memory HiCorder Operations
______________________________________________________________________________________________

Key panel

Example: 8841/42

3.4 Memory HiCorder Operations

Once connected to the Memory HiCorder, the following Screen image and
key panel appear in the window.

Clicking a key button in the key panel with the mouse has the same effect as
pressing the corresponding button on the Memory HiCorder.
In MR8827, MR8847A, MR8847, 8847, MR8740, MR8741, it can be
manipulated by clicking directly on the screen. If you want to change the
settings, click the Settings item you want to change first, and then click the
GUI buttons next.
During measurement, the response from the Memory HiCorder is somewhat
slower, but the software can be used for simple monitoring.
To end the connection to the Memory HiCorder, in the Connection menu
select Disconnect.

You can change the size and orientation of the screen image display.
In the menus:
View > Select [Fix display size] to display the same display resolution as

Memory HiCorder display. When the entire display cannot be
viewed, scroll to view it.

View > Select [Adjust display size] to reduce or enlarge the Memory
HiCorder display to fit and display the entire view in the window.

View > Orientation > Landscape (8841/42, 8720 only)
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3.4 Memory HiCorder Operations
______________________________________________________________________________________________

STATUS Ten-key of 7 Shuttle 0，-，^，\
CHAN Ten-key of 8 Jog @，「
DISP Ten-key of 9 START Enter
SYSTEM Ten-key of 4 STOP Space
TRIG Ten-key of 5 MANU TRIG m
FILE Ten-key of 6 CH.SET c
VALUE Ten-key of 1 LEVEL MONI l
WAVE Ten-key of 2 VIEW v
A.B CSR Ten-key of 3 AUTO a
Up and down
Right and left Cursor key HELP h

F1 to F10 1 to 9, o

NOTE
･ The response is slower than when operating on the Memory HiCorder itself, and

after pressing a key you should wait a moment for the effect to appear on the
screen. This is because the key code and new screen image have to be transferred
over the LAN.
･ It is possible to make settings such as the LAN address by remote control, but as

the setting takes effect, the connection is lost. Such operations should therefore be
avoided.
･ When the recorder function display format is X-Y, during measurement the

display cannot be updated.

View > Orientation > Portrait (default) (8841/42, 8720 only)
When [Adjust display size] is selected and the window is reduced, the
display with letters and waveforms becomes less readable. Use it only during
monitoring.

In the View menu, if Enable Screen Keys is checked, you can also press the
keys (GUI) on the Memory HiCorder screen.
Places where it is not possible to make settings are shown by a mark ( ).

Keyboard operations
In the View menu, select Key Dialog Bar, and set the key panel display to
OFF in order to use the keyboard. The key allocations are as shown below.
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3.5 Receiving Waveform Data
______________________________________________________________________________________________

3.5 Receiving Waveform Data

You can transfer waveform data from memory in the Memory HiCorder to
the computer. The data is transferred as a file in the same format as in a
binary save to recording media on the Memory HiCorder.
Select Data Transfer, then Get/Save Waveform Data.
When the dialog box appears, enter the location (directory) to save the file
and the file name.
Next click Start, to start receiving the waveform data from the Memory
HiCorder.

While the data is being transferred, the progress is shown at the lower right
corner of the application window. When this bar reaches the right edge the
transfer is complete. (When transferring more than one file, the progress bar
wipes across for each set of waveform data.)
When the A/B cursors are present on the screen, only the section between
the cursors is transferred. When the cursors are not shown the whole of the
data is transferred: always check the cursors before sending.
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3.5 Receiving Waveform Data
______________________________________________________________________________________________

After completing data transfer, the following dialog appears.
Double click the displayed file name or select the file name and click [Wv]
button to start up waveform view to display the waveform file.
Also click [Explorer] button to start up Explorer and see the folder that
contains the saved files.
Transferred files can be converted to ASCII data and be used in EXCEL,
copied to floppy disk and be loaded in Memory HiCorder.
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3.6 Printing Waveform Data
______________________________________________________________________________________________

NOTE
･ The print image color selection feature (Color/Monochrome) is disabled on the MR8827,

MR8847A, MR8847, 8847, MR8740, MR8741, 8855. This is always set to
monochrome. This feature is disabled on the 8730, 8731.

3.6 Printing Waveform Data

You can print waveform data from the Memory HiCorder on a printer
connected to the computer, in place of the internal printer of the Memory
HiCorder.

Go to [Data Transfer] and select [Get/Print Report Image] to display the
following dialog. Select print data (color/black&white) to be received and
click [Get] button to start receiving data.

During receiving, progress is displayed on the bottom right in the application
window. When the bar reaches the right end, data transfer is complete.

The following dialog box then appears.

･ Print : Print the data. Note that this is in report print format.
･ Print Preview : Preview the printing image on the screen.
･ Page settings : Set the printing layout.
･ Cancel : Cancel printing.
･ Save to File :Save the data in bitmap file format.

When you select Print here, the report print image is output to the
computer's printer.
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3.7 Other Functions
______________________________________________________________________________________________

3.7.1 Changing the Connection Timeout Setting

NOTE
When the remote control application and data collection application are used
simultaneously, while the data collection application is transferring data, remote
control of the Memory HiCorder is not possible. Since in this case the remote
control could time out, select "No Timeout."

3.7 Other Functions

The remote control application carries out various data transactions with the
Memory HiCorder. If the LAN is busy, responses may be delayed, and if the
delay with no response exceeds a preset limit, a timeout occurs, and the
network is disconnected. You can change the setting of this timeout limit,
increasing it if a busy network causes frequent timeouts. If the network
connection is functioning normally, there is no need to change this setting.
In the Connection menu, select Timeout Settings, to display the dialog box.
Enter the new time limit here.
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3.7 Other Functions
______________________________________________________________________________________________

3.7.2 Changing the Screen Image Transfer Interval

3.7.3 Changing the Key Repeat Interval

The screen image display is normally updated each time there is a key panel
press, directly after measurement ends (or at the measurement interval when
the trigger mode is continuous or auto), and at regular intervals.
You can change this regular interval for the update. Making it shorter
improves the screen image display response, but increases the load on the
LAN and the Memory HiCorder. Making it longer decreases the screen
image display response, but also lightens the load.
You can also stop the interval transfer, but in this case only the screen
image immediately following the last key panel press will appear, so when
carrying out processing that takes a significant time it will not be possible to
determine when the operation has completed, because the screen image is
not updated.
Normally the default setting should not require changing, but if the Memory
HiCorder appears to be under a heavy load, or to reduce the load on the
LAN, increase the setting.
In the Connection menu, select Screen Interval Transfer Settings to display
the dialog box. Enter the new setting as required.
The transfer interval depends on the load state of the Memory HiCorder, and
may be longer than the set value.

When you hold down a key panel button, the key information is sent
repeatedly to the Memory HiCorder. This setting determines the repeat
interval; it is best to adjust the setting after using the current setting. Since
the response of the Memory HiCorder varies according to the current task,
even if adjusted for operation on one screen, this may not necessarily be the
best setting for all screens.
In the Connection menu, select Set Key Repeat Settings, to display the
dialog box. Enter the new setting as required.
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3.7 Other Functions
______________________________________________________________________________________________

3.7.4 Saving the Screen Image

3.7.5 Printing a Screen Image

3.7.6 Changing the Printing Settings

You can save the Memory HiCorder screen image displayed in the window
of the remote control application as a bitmap file in the computer's file
system.
This is convenient for saving a measured waveform as a screen image, or to
copy a settings screen for documentation purposes.
In the Connection menu, select Save Screen. A dialog box asks where you
want to put the screen image. Click Save to save the screen image as a
bitmap file.

You can print the Memory HiCorder screen image displayed in the window
of the remote control application on the computer's printer.
This is convenient for printing a measured waveform as a screen image, or
when printing a settings screen for documentation purposes.
In the Connection menu, select Print Screen. The printing dialog box
appears: click OK to print.
To change the printer settings, click Properties. The printer settings depend
on the particular printer: refer to the documentation supplied with the printer
for details.
You can also preview the effect of the printing. To do this, in the Connect
menu select Print Preview.

When printing a screen image or report print on the printer, you can change
the printing settings on the fly, or you can make the settings here in
advance.
In the Connection menu, select Page Settings. A dialog box appears: make
the printing settings in it as required.

When you exit the application, the printing settings are not saved, and thus
when the application starts, they revert to the Windows default printer
settings.
Set the Windows printer settings by clicking the "My Computer" icon on the
Windows desktop, selecting Printer, and in the dialog box selecting
Properties.
For more details, see the Windows Help or the printer documentation.
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3.7 Other Functions
______________________________________________________________________________________________

3.7.7 Comment Transmission Function

Example: 8841/42

3.7.8 Escaping from the Key Check Screen

Using the comment transmission function, you can conveniently prepare
comments on the computer, and transfer them to the Memory HiCorder.
In the Data Transfer menu, select Get/Send Comments. This displays a table
of the comments stored in the Memory HiCorder.

Click with the mouse on the channel where you want to change the
comment, and enter the new comment. After setting the comments, click the
Send button to transfer them to the Memory HiCorder.

There are some keys which are present on the Memory HiCorder itself, but
not on the key panel of the remote control application. Therefore, if you
enter the Memory HiCorder key check screen under remote control (System
screen, self-check), it will not be possible to complete the key Check.
In this case, in the Data Transfer menu, select Escape from Key Check
Screen. This has the effect of pressing the Memory HiCorder START and
STOP keys simultaneously, and exits the key check screen.
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3.7 Other Functions
______________________________________________________________________________________________

3.7.9 Send Print Key

NOTE This feature is disabled on the 8730, 8731.

3.7.10 Version Information

Selecting Send/Receive Data and Send Print Key on the Menu bar has the
same effect as pressing the PRINT key on the Memory HiCorder.
When you specify "Interface" for the "PRINT Output" of the Memory
HiCorder and select the "Send Print Key" while waiting for the data
collection (Accumulator), you can output the data to the printer connected to
the computer.

When making inquiries, the version number will be required.
To check the software version number, in the Help menu select About
RmCtrl. To check the version number of the Memory HiCorder, select About
the Memory HiCorder.
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3.7 Other Functions
______________________________________________________________________________________________
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______________________________________________________________________________________________

Chapter 4
Data Collection (Accumulator)

By starting the data collection application (Accumulator) on the computer,
you can use the following functions.

･ Saving Memory HiCorder auto save files to the computer
･ Using the computer printer for a Memory HiCorder auto print
･ Using the computer printer for a Memory HiCorder screen hard copy
･ Using the computer printer for the Memory HiCorder PRINT key function

With these functions, you can collect data from a number of Memory
HiCorders on a single computer, constantly save the measurement data to the
computer, print in color using a color printer with the computer, print on
plain paper for archiving, and access data on the computer regardless of the
physical location of the Memory HiCorder.
When the Memory HiCorder auto save function is used to transfer a file,
when the Memory HiCorder A/B cursors are present, only the section
between the cursors is saved. In other cases all of the data is saved. The
waveform file is in binary format only (text format can be selected in
MR8827, MR8847A, MR8847, 8847, MR8740, MR8741, 8730, 8731,
8855).



24
_____________________________________________________________________________________________

4.1 Starting the Data Collection Application
______________________________________________________________________________________________

4.1 Starting the Data Collection Application

In the Windows Start menu, select Programs, HIOKI, 9333 LAN
Communicator, and Data Collection. This starts the data collection
application.
To close the data collection application, in the Server menu select Exit. You
can also click the Close button at the top right corner of the window.

Toolbar
Click the icons in the toolbar for the respective functions.
From the left, these are: Start Standby, End Standby, Server Settings, Printer
Settings, Start Explorer, Start Waveform Viewer, Auto Scroll.
For details of these operations, see the descriptions of the corresponding
menu items.

Status bar
The status bar shows, from the right, the current number of connections,
total size of files received, free disk space, the root path, and the port
number.

Version information
When making inquiries, the version number will be required.
To check the software version number, in the Help menu select About
Accumulator.
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4.2 Data Collection Menus
______________________________________________________________________________________________

[ Server ]

[ Server Settings ]

[ Help ]

[ Log Settings ]

[ View ]

[ Start Standby ] Refer to 4.4

[ End Standby ] Refer to 4.4

[ Port number ] Refer to 4.3.1

[ Start standby when program starts ]
 Refer to 4.4

[ Save Settings ] Refer to 4.3.2

[ Print Image Color Settings ] Refer to 4.3.3

[ Printer Settings... ] Refer to 4.3.4

[ Save ] Refer to 4.5

[ Do Not Save ] Refer to 4.5

[ Set File... ] Refer to 4.5

[ About Accumulator ] Refer to 4.1

[ Status Bar ] Refer to 4.1

[ Toolbar ] Refer to 4.1

[ Auto Scroll ] Refer to 4.5

[ Start Waveform Viewer ] Refer to 4.5

[ Start Explorer ] Refer to 4.5

[ Exit ] Refer to 4.1

[ Option ]

4.2 Data Collection Menus

The following is the complete menu tree of the data collection application.
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4.3 Preparation for Data Collection
______________________________________________________________________________________________

4.3.1 Selecting the Port to Go on Standby

4.3 Preparation for Data Collection

Before beginning data collection, the following preparations are necessary.
1. Selecting the port to go on standby
2. Making save settings
3. Selecting the print image color
4. Printer settings
5. Memory HiCorder settings

Before beginning data collection, it is necessary to select the port to go on
standby. This is indicated by the TCP/IP port number.
Set to the TCP/IP port number of the Memory HiCorder. (See Section 2.4)
In the menu bar, select Server, then Server Settings to display the Server
Settings dialog box.

If the Memory HiCorder setting is "880x", here enter "8801", replacing the
"x" by "1". For example, for "987x" enter "9871".
If you check the Start Standby when Program Starts box, then the data
collection application starts data collection as soon as you launch it. (See
Section 4.4.)
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4.3 Preparation for Data Collection
______________________________________________________________________________________________

4.3.2 Making Save Settings

In the menu bar, select Server, then Server Settings, to display the Server
Settings dialog box.
In the Folder to Receive Waveform Data box, specify where to save data
received from the Memory HiCorder. (See Section 4.5.)
In the Stop Accepting Waveform Data when Free Disk Space Reaches box
enter the minimum required free disk space.
Especially when important Windows files such as a swap file, temporary
directory are placed on the same disk, use caution because Windows
operation may possibly become unstable due to insufficient free disk space.
Check [Delete old files] check box to automatically delete old files (only
during waiting period) after starting up data collection application software
and total size of file received exceeds the size set for saving in this setting.
It deletes from the oldest file displayed in the list on the display
chronologically. When data collection application software is restarted, the
file previously collected is not displayed in the list and so cannot be selected
for deleting.
When a large volume of waveform data files are transferred and deleting is
not fast enough filling up specified free disk space, data collection stops.
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4.3 Preparation for Data Collection
______________________________________________________________________________________________

4.3.3 Selecting the Print Image Color

NOTE
･ With the 8720, you cannot specify colors on the Memory HiCorder. Colors are

automatically selected when you select the Memory HiCorder setting.
･ This is always set to monochrome for the MR8827, MR8847A, MR8847, 8847,

MR8740, MR8741, 8855.

4.3.4 Printer Settings

In the menu bar, select Server, then Server Settings, to display the Server
Settings dialog box.
In this dialog box you can select the color used to print data received from
the Memory HiCorder. You can select color, monochrome, or the colors set
on the Memory HiCorder. The color/monochrome setting takes precedence
over the Memory HiCorder setting (on the System screen).

You can make settings as required for printing from the data collection
application.
In the Server menu, select Printer Settings. A dialog box appears: make the
printing settings in it as required.

When you exit the application, the printing settings are not saved, and thus
when the application starts, they revert to the Windows default printer
settings.
Set the Windows printer settings by clicking the "My Computer" icon on the
Windows desktop, selecting Printer, and in the dialog box selecting
Properties.
For more details, see the Windows Help or the printer documentation.
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4.3 Preparation for Data Collection
______________________________________________________________________________________________

4.3.5 Memory HiCorder Settings

This section describes the settings on the Memory HiCorder for using the
data collection application.
By starting the data collection application (Accumulator) on the computer,
you can use the auto save and auto print functions of the Memory HiCorder
on the computer disk or printer.

Setting the data collection server IP address
It is necessary first to set the IP address for the data collection server, in the
System screen. This is part of the Memory HiCorder System screen interface
settings.
Move the flashing cursor to Data Collection Server, and use the function
keys or jog dial to set the same IP address as on the computer.

Auto save setting
You can use the Memory HiCorder auto save function on the computer
running the data collection application.
To do this, in the Memory HiCorder Status screen, set the auto save
destination to Communications (LAN). Note that in this function the
waveform data is transferred in binary (text format can be selected in
MR8827, MR8847A, MR8847, 8847, MR8740, MR8741, 8730, 8731,
8855).

Auto print setting
You can use the Memory HiCorder auto print function on the computer
running the data collection application.
To do this, in the Memory HiCorder Status screen, set the auto print
destination to Communications (LAN).

Hard copy destination setting
You can use the Memory HiCorder screen hard copy function on the
computer running the data collection application. To do this, in the System
screen set the COPY key output to Communications.
You can select color or monochrome output.
Now when you press the Memory HiCorder COPY key, the screen image
will be printed on the computer.

Print destination setting
You can print whatever is printed by pressing the Memory HiCorder PRINT
key on the computer running the data collection application.
To do this, in the System screen set the PRINT key output to
Communications.
You can select color or monochrome output.
Now when you press the Memory HiCorder PRINT key, the printing will
appear on the printer connected to the computer.
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4.3 Preparation for Data Collection
______________________________________________________________________________________________

NOTE
･ Using the 8720

Specify Communications (LAN) as the auto-save destination in the Memory
HiCorder Status screen. This allows you to send the measured waveform, screen
shot, and printed waveform to the 9333 simply by pressing the SAVE/COPY key.
To specify desired colors, see "Selecting the Print Image Color" in Section 4.3.3
for more details. If you select the Memory HiCorder setting, colors are selected
automatically on the 8720.
･ Using the 8855

To specify the IP address, select System and Interface.
To specify auto-save, select System and File Save.
After selecting System, File Save, Set SAVE key Setting, and Save Media, and
specifying LAN as the destination, you can send the measured waveforms, screen
shot (hard copy data), and printed waveform to the 9333 by pressing the SAVE
key. For information on specifying colors, see "Selecting the Print Image Color" in
Section 4.3.3
･ Using the MR8827, MR8847A, MR8847, 8847, MR8740, MR8741.

To specify the IP address, select System screen - [Interface] sheet.
To specify auto-save, select System screen - [File Save] sheet.
After specifying LAN as the destination of SAVE key, you can send the measured
waveforms, screen shot (hard copy data), and printed waveform to the 9333 by
pressing the SAVE key. For information on specifying colors, see "Selecting the
Print Image Color" in Section 4.3.3
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4.4 Starting Data Collection
______________________________________________________________________________________________

This shows the transfer log.

This shows the current status.
(Port number, path, free disk space, total size of files received, current number of

connections)

4.4 Starting Data Collection

In the Windows Start menu, select Programs, HIOKI, 9333 LAN
Communicator, and Data Collection. This starts the data collection
application.

Starting standby
After completing the server settings, in the Server menu, select Start
Standby: this puts the application on standby.
Now when save data is transferred from the Memory HiCorder it is accepted
and saved on the computer. When print data is transferred from the Memory
HiCorder, it is printed on the computer.

To start the application automatically when the computer is started up
When a computer is dedicated to the data collection task, you can have the
computer start data collection as soon as it is started up. To do this, add this
application to the Windows Startup. (For more details, refer to the Windows
help.)
In the directory in which the 9333 software is installed, the program is the
file "Accumulator.exe": add a shortcut to this file to Startup.
Next, in the data collection application settings, check the Start Standby
when Program Starts box. (See Section 4.3.1.)
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4.5 Location of Saved Files
______________________________________________________________________________________________

[ root ] Host name 1 99-10-10 WAVE101000.MEM

WAVE101100.MEM

99-10-11 WAVE201100.MEM

Host name 2 99-10-10 WAVE201100.MEM

WAVE201111.MEM

99-10-11 WAVE201100.MEM

4.5 Location of Saved Files

Files obtained by data collection are saved as follows.

The root directory for the files is the directory set in the data collection
application as Folder to Receive Waveform Data.
Within this directory, there is a directory name after the Host Name, as set
on the Memory HiCorder.
Further below this directory, there are subdirectories named by the date. The
files are saved in the directory with today's date.
The files are saved as "PARAMETER.TXT" if a parameter calculation file,
or "WAVEHHMMSS.[extension]" if a waveform data file.
Here the "HHMMSS" is the time in hours, minutes, and seconds. If two file
names would otherwise be the same, a numeric suffix is attached.

Starting Explorer
In the View menu, select Start Explorer, or in the display list, right-click on
an item, and select Browse with Explorer. Either method starts Explorer.

Using the waveform viewer
For saved waveform files, double-click an item in the display list, or right-
click and select View with Waveform Viewer, and display the waveform.
Once a file has disappeared from the display list, use the waveform viewer
to open the corresponding file to display it. You can also start the waveform
viewer by selecting Start Waveform Viewer in the View menu.
･ You can select the waveform viewer to start in the setup screen displayed

by selecting Display with Setup from the menu.

Display auto scrolling
In the View menu, check Auto Scroll to scroll the display automatically so
that when a new item is added to the list it is always within view.
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4.5 Location of Saved Files
______________________________________________________________________________________________

Transfer log
You can save a log of the collected data transfers (when, from where, and
what was transferred). You can check this file to find out what transfers
have occurred.
In the Server menu, select Log Settings, then Set File, to display the File
Settings dialog box.
Once you enter a file name here, logging starts.
In the Server menu, select Log Settings, then Save/Do Not Save to toggle the
logging on and off.

Organizing saved data
Collected data is saved in sequence as it is received. If the settings are such
that a very large volume of data will be saved, the free disk space may be
rapidly used up. When the free disk space falls below the set level, data
collection stops. Use the following methods to ensure that this does not
happen.
･ Expand the computer's hard disk capacity.
･ Manage the files frequently, deleting any that are not required, or

transferring them to other media. Note that moving files to the Recycle Bin
does not of itself increase the free disk space: you also need to empty the
Recycle Bin.
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4.5 Location of Saved Files
______________________________________________________________________________________________
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______________________________________________________________________________________________

Chapter 5
Waveform Viewer (Wv)

This provides simple viewing of data transferred to the computer using the
remote control and data collection applications. It also has a function to
convert to CSV file format, after which you can load the data into a
spreadsheet or other software.
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5.1 Starting the Waveform Viewer
______________________________________________________________________________________________

5.1 Starting the Waveform Viewer

In the Windows Start menu, select Programs, HIOKI, 9333 LAN
Communicator, and Waveform Viewer. This starts the waveform viewer
application.
To close the waveform viewer application, in the File menu select Exit. You
can also click the Close button at the top right corner of the window.

Toolbar
Click the icons in the toolbar for the respective functions.
From the left, these are: Open, Save Whole Data, Save Between Cursors,
Batch Conversion, Properties, Waveform Control Panel, Trace, Zoom Out,
Zoom In, and Exit.
For details of these operations, see the descriptions of the corresponding
menu items.
You can also select the magnification factor for the time axis by selecting on
the toolbar.

Status bar
The status bar shows, from the left, the model name, function, recording
length, time axis, trigger time, pre-trigger, and judgment result.

Version information
When making inquiries, the version number will be required.
To check the software version number, in the Help menu select About Wv.
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5.2 Waveform Viewer Menus
______________________________________________________________________________________________

[File] [ Open ] Refer to 5.3

[ Save All ] Refer to 5.4

[ Save Between Cursors ] Refer to 5.4

[ Exit ] Refer to 5.1

[ Batch Conversion ] Refer to 5.5

[ Properties ] Refer to 5.3

[View] [ Toolbar ] Refer to 5.1

[ Status Bar ] Refer to 5.1

[ Zoom In ] Refer to 5.3

[ Zoom Out ] Refer to 5.3

[ Set Magnification ]  Refer to 5.3

[ Wave Control Panel ] Refer to 5.3

[ Trace ] Refer to 5.3

[ Block List ] Refer to 5.3

[ Time Notation ]

[ Remarks ] Refer to 5.3

[ Fixed ] Refer to 5.3

[ Jump ]

[ A Cursor ] Refer to 5.3

[ B Cursor ]

[ Sec ]

[ DIV ]

[ Point ]

[ Trig ]

[ Date ]

[ Trig ] 

[ Title ] Refer to 5.3

[ Capture ] Refer to 5.3

[ Grid Type ]

[ Standard ] Refer to 5.3

[ Fine ]

[ None ] 

[ Gauge ] 

5.2 Waveform Viewer Menus

The following is the complete menu tree of the waveform viewer application.
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5.2 Waveform Viewer Menus
______________________________________________________________________________________________

Right-click with
the mouse [ Wave Control Panel ]

[ Properties ]

[ Zoom In ]

[ Zoom Out ]

[ Set Magnification ]

[ Color ]

[ Font ] Refer to 5.3

[ Background ]  Refer to 5.3

[ Text ]

[ Grid ]

[ Block List ]

[ Trace ]

[ Time Notation ]

[ Jump ]

[ A Cursor ]

[ B Cursor ]

[ Sec ]

[ DIV ]

[ Point ]

[ Trig ]

[ Date ]

[ Trig ]

[ Remarks ]

[ Fixed ]

[ Capture ] Refer to 5.3

[ Title ]

[ Grid Type ]

[ Standard ] Refer to 5.3

[ Fine ]

[ None ] 

[ Gauge ] 

Right-click with the mouse in the waveform display screen for the following
functions.
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5.3 Using the Waveform Viewer
______________________________________________________________________________________________

5.3 Using the Waveform Viewer

Waveform display
To display a waveform it is first necessary to select the file to be displayed.
In the [File] menu, select [Open], to display the file selection dialog box.
Select a waveform file, and click Open to read in the file, and display the
waveform.

Changing the time axis scale (zoom function)
You can change the time axis scale in the display using the menus or
toolbar.
In the toolbar, click the Magnification box, to display the possible zoom
factors: you can then select any desired value.
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5.3 Using the Waveform Viewer
______________________________________________________________________________________________

CH
This indicate the list of channel.
When a check mark is present the corresponding channel is
displayed.

Zoom Set the magnification on the voltage axis for the specified
channel.

Posn Set the position of the specified channel.

Show Display the specified channel(s).

Hide Do not display the specified channel(s).

Show All Display all channels.

Hide All Do not display all channels.

Color >> Change the color of the specified channel(s).

Default Set all values of the specified channel(s) back to their default
values.

Close Close the Waveform Control Panel.

Changing waveform scale and position (Waveform Control Panel)
You can adjust the display for each channel separately. In the [View] menu,
select [Waveform Control Panel] to display a dialog box.

Checking the waveform measurement conditions (Properties)
Select [View], then [Properties] from the menu to display the measurement
settings on the MEMORY HiCORDER.

Checking voltage values (Trace)
Select [View], then [Trace] from the menu to check the time value and
difference of the two cursors (A and B) and the voltage values and
differences of all channels.

File list in index file
Select [View], then [Block List] to check the file list (block number,
filename, time axis range, trigger time) in the index file.
Double-click a file in the list opens a new window in which you can check
waveform in that file.
* This is effective only when reading Sequential, Multi-block, REC&MEM
index files.
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5.3 Using the Waveform Viewer
______________________________________________________________________________________________

Waveform jump function
Select [View], then [Jump] to jump to the trigger position or the positions of
the A or B cursors.

Time Notation
Select [View], then [Time Notation] to change the time notation on the
waveform screen.

Grid Type
Select [View], then [Grid Type] to change the grid type.

Title comment display
Select [View], then [Title] to display title comments in the top of the
waveform screen.

Waveform legend view
Select [View], then [Remarks] to view the unit type of each channel, the
measurement mode, measurement range, filters, comments, scaling, display
position and magnification on the portion below the waveform screen.

Fixing waveform view conditions
Select [View], then [Fixed] to always view waveforms with the same color,
display position and magnification.
When this item is enabled, the file view settings are disabled.
The standard values for display conditions are automatically saved when the
application is terminated or when the check mark is removed from [Fixed]
menu.

Setting the display colors
Right-click on the waveform display screen, and select [Color], then
[Text]/[Background]/[Grid] to display a dialog box for setting the respective
colors.

Font settings (character size)
Right-click on the waveform display screen, and select [Font], to display the
font setting dialog box. You can then select the font for text on the
waveform display screen.

Waveform display snaps (capture)
Select [View], then [Capture] to capture waveform display and copy to
clipboard as a bit image. You can paste it into other applications.
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5.4 Conversion to CSV Format
______________________________________________________________________________________________

Cursor

5.4 Conversion to CSV Format

You can convert displayed waveform data to a CSV format file. Once in
CSV format, the file can be loaded into spreadsheet or other software for
further processing. You can either convert the whole data file or a range
selected with the cursors.
If selecting a range, first set the cursors to the required positions. These are
indicated at the top of the waveform screen by inverted blue and red
triangles: drag these triangles with the mouse to set the range.

Then to save all of the data, in the [File] menu, select [Save All]; to save the
range only, in the [File] menu, select [Save Between Cursors].
A dialog box appears for setting the file to be saved, and the thinning.
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5.4 Conversion to CSV Format
______________________________________________________________________________________________

To save in text formats other than CSV (space delimited or tab delimited),
select the desired format from the [Save as type] list.
In the Thinning box, enter the number of original samples corresponding to
one converted value.
Use this when data over a large range (long time interval) is required, but
the whole set of sampled data is not required.
In the Time Notation box, select the appropriate time notation from Sec,
Date, Trig, Point.
Enter the name of the file to be saved, and click the Save button to convert
the data to CSV format and save the file.
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5.5 Converting Multiple Waveform Files into CSV Files
______________________________________________________________________________________________

5.5 Converting Multiple Waveform Files into CSV Files

You can convert multiple waveform files into CSV files.

1. Select [File] from the menu bar, then select [Batch Conversion] from the
File menu.

2. Select the desired files from the file list. To select two or more files, left-
click on the desired files while holding down the Shift or Control key.

3. If required, specify the sampling intervals at which data is to be
converted. Remember that not all data needs to be converted. This setting
is useful when you need data over a broad time span.

4. In the Output, specify the folder in which to save the CSV files converted
from waveform files. You can specify the desired folder without typing
simply by clicking on the Ref button and selecting the desired folder from
the list.

5. To save in text formats other than CSV (space delimited or tab delimited),
select the desired format from the [Save as type] list.

6. In the Time Notation box, select the appropriate time notation from Sec,
Date, Trig, Point.

7. Click the Convert button. All selected waveform files are converted to
CSV files and saved in the specified folder.
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